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This document provides information for installing and configuring the Microsoft® SQL Server™ 2005 
Standard Edition with SP2 software following Dell’s recommended configurations for SQL Server 2005.

The following topics are covered:

• Software and hardware requirements

• Installing and configuring Microsoft® Windows Server® 2003 R2 Edition with SP2

• Configuring networking and storage for SQL Server 2005 database

• Configuring MSCS Clustering for SQL Server 2005

• Installing SQL Server 2005 and software updates

• Additional information

• Troubleshooting

For more information on Dell’s supported configurations for SQL Server 2005, see the Dell|SQL Server 
solutions website at dell.com/sql.

If you purchased the SQL Server 2005 Deployment Service, your Dell Professional Services 
representative will assist you with the following:

• Verifying hardware and software configurations

• Configuring networking and storage

• Installing SQL Server 2005 Standard Edition

• Installing SQL Server 2005 Service Pack 2

Software and Hardware Requirements
For a list of the minimum supported hardware and software components for this solution, please refer to 
the Solution Deliverable List (SDL) document on dell.com/sql.

 NOTE: Depending on the number of users, the application you use, your batch processes, and other factors, 
you may need a system that exceeds the minimum hardware requirements in order to achieve your desired 
performance. For initial sizing information, please refer to the following link: dell.com/sql.

License Agreements

 NOTE: If you do not have a SQL Server 2005 software license, contact your Dell sales representative.

Important Documentation

For more information on specific hardware components, see the documentation that came with your system.
Deployment Guide 5



Installing and Configuring the Operating System
This section provides information about installing and configuring the Windows Server 2003 R2 
Standard or Enterprise Edition with SP2 operating system for SQL Server 2005 deployment. This 
Deployment Guide requires a companion Dell Database Resource CD to complete the installation on 
EMC Fibre Channel Storage. Please download the Dell Database Resource CD from dell.com/sql.

Using the Dell™ PowerEdge™ Installation and Server Management Media to Perform a Clean 
Installation of the Operating System

Use the Dell PowerEdge Installation and Server Management CD that shipped along with your server to 
ensure that all the supported drivers for the Windows operating system are installed.

 NOTE: If you purchased a Dell system without an operating system, Dell strongly recommends that you use the 
supported version of the Dell PowerEdge Installation and Server Management media to guide you through the 
operating system installation. The Dell PowerEdge Service and Diagnostic Utilities media contains the latest drivers 
available at the time you purchased your Dell system. See the Dell Support website at 
support.dell.com/support/downloads for any updated drivers that were not included on your Dell PowerEdge 
Service and Diagnostic Utilities media. The Dell Database Resource CD contains software drivers such as EMC 
Fibre Channel and NIC Teaming that are not included in the Operating System base drivers. Download the Dell 
Resource CD from dell.com/sql.

 NOTE: To update base drivers, use the Dell PowerEdge Service and Diagnostic Utilities media.

The Dell PowerEdge Installation and Server Management media guides you through the operating 
system installation procedure and installs the Dell-specific device drivers that are not on the operating 
system media.

 NOTICE: During the installation procedure, all data is erased from your hard drive. Dell recommends that you back 
up your data before you perform this procedure.

Installing Microsoft Windows Server 2003 R2, Standard or Enterprise Edition with SP2 Using the 
Dell PowerEdge Installation and Server Management CD

1 Connect a keyboard, mouse, and monitor to your system.

2 Turn on your system.

3 Insert the Dell PowerEdge Installation and Server Management CD into the CD drive.

4 Press <Ctrl><Alt><Delete> to restart your system.

5 If you are not using the Dell PowerEdge Installation and Server Management CD for the first time, the 
Welcome to Dell OpenManage™ Server Assistant window appears. Go to step 7.

6 If you are using the Dell PowerEdge Installation and Server Management CD on your system for the first 
time, perform the following steps:

a When prompted, click the appropriate language for your system.

The Dell Software License Agreement window appears. 

 NOTE: Read the information carefully.
6 Deployment Guide



b If you agree with all of the information, click Accept to continue.

c If you do not agree with all the information, click Decline. 

 NOTE: When you click Decline, your system will restart and you will not be able to complete the operating 
system installation.

7 Click Server OS Installation for Server Setup to install the operating system.

The Set the Date and Time window appears.

8 Select the appropriate date, time, and time zone; then, click Continue.

The Operating System to Install window appears.

9 Select Microsoft Windows Server 2003 x86 Edition Service Pack 2.

10 Click OK, and then click Continue.

11 To set up a new boot partition, select the appropriate file system and size for your partition and click 
Continue.

 NOTICE: If there is an existing partition on the hard drive, the Confirm to delete partition window appears. Click 
Continue. Server Assistant deletes all existing partitions on the hard drive.

 NOTE: For maximum system security, Dell recommends selecting NTFS File System.

The Network Adapter(s) configuration window appears.

12 Select one of the following options and click Continue:

a Obtain IP address from DHCP server.

b Specify an IP address

The Enter Configuration Information Edition window appears.

13 Type your system information in the appropriate fields and click Continue.

 NOTE: By default, the Open Manage Server Assistant (OMSA) check box is selected. This property will prompt for 
the OMSA CD that came with your system and install it automatically during the OS install.

 NOTE: If you are not using the media provided by Dell, enter the Windows Product Key at this stage.

The Operating System Installation Summary window appears.

14 If the configuration settings are correct, click Continue.

The Microsoft Windows Installation Wizard window appears. The file copy process starts.

15 If the configuration settings are not correct, perform the following steps:

a Click Back until the appropriate screen appears.

b Enter the correct information.

c Click Continue until the Microsoft Windows Installation Wizard window appears.

16 When prompted, insert the Microsoft Windows Server 2003 R2 Standard Edition with SP2 Disk 1 or 
Microsoft Windows Server 2003 R2 Enterprise Edition with SP2 Disk 1 CD into the CD drive.
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The Dell OpenManage Server Assistant automatically detects the CD and begins copying the operating 
system files.

 NOTE: This procedure may take several minutes to complete.

17 When prompted, remove the CD from the CD drive, and click Finish.

Your system automatically restarts, Windows Setup appears in text mode, and the installation continues.

 NOTE: If Console Redirection is enabled in the System Setup program, you are prompted for an administrator 
password in the text mode of Windows Setup. Enter an administrator password and press Enter to continue. The 
Emergency Management System window appears. Click OK to continue.

Windows Setup automatically restarts your system, and the Windows Setup window appears. Windows 
Setup completes the installation and restarts your system.

18 In the Log On window, type your administrator password, and click OK.

The system prompts you to insert the Microsoft Windows Server 2003 SP2 Disk 2 CD.

 NOTE: If you want to install the optional R2 components, click OK and then see the "Installing the R2 Components" 
on page 8 to complete the installation.

19 Click Cancel to proceed with the operating system installation without installing the optional R2 
components.

The Windows Setup dialog box appears with directions on how to continue with the second CD install 
at a later time.

20 Click OK.

The Windows Server Post-Setup Security Updates window appears.

 NOTE: At this time, your Windows firewall is disabled. Dell recommends that you update your system with the 
latest critical security updates and configure Automatic Updates before you click Finish.

21 Click Finish.

22 Click Yes to close the window.

The Manage Your Server window appears.

The operating system is now installed on your system. If you need additional information to complete 
the rest of the installation, see the documentation that came with your software or go to the Microsoft 
Support website at www.support.microsoft.com.

Installing the R2 Components

Perform the steps below to install the optional R2 components:

1 Insert the Windows Server 2003 R2 Disk 2 CD into the CD drive, and then click OK.

The Welcome to the Windows Server 2003 R2 Setup Wizard window appears.

2 Click Next.

The End-User License Agreement window appears.
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3 If you agree with the information, accept the license terms and click Next.

 NOTE: If you do not agree with the information in the End-User License Agreement, click Cancel. Installation of the 
optional R2 components will terminate.

The Setup Summary window appears.

4 Click Next.

The Completing Windows Server 2003 R2 Setup window is displayed.

5 Click Finish.

The following is a list of optional R2 components available on the Windows Server 2003 R2 Disk 2 CD:

• Active Directory Application Mode

• Active Directory Federation Services

• Identity Management for UNIX

• Distributed File System

• File Server Management

• File Server Resource Manager

• Hardware Management

• Print Management Component

• Storage Manager for SANs

• Microsoft.NET Framework 2.0

• Common Log File System

• Microsoft Services for NFS

• Subsystem for UNIX-based Application

• Windows SharePoint Services

 NOTE: For more information on the R2 components, go to 
www.microsoft.com/WindowsServer2003/R2/default.mspx.

 NOTE: If you are installing the Hardware Management component on a recently released Dell system, a message 
appears containing information about third-party IPMI drivers. For more information on this message, see the 
document Important Information for Windows Server 2003.

Installing Specific R2 Components on Your System (optional)

Perform the steps below to install a specific R2 component on your system:

1 Log on as an administrator and click Start→Settings→Control Panel, and then double-click on Add 
or Remove Programs.

2 Click on Add/Remove Windows Components.

The Windows Components Wizard window appears.
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3 Select the R2 components you want to install, and follow the prompts on the screen to complete the 
installation.

Installing Internet Information Services (IIS) using the Windows Server 2003 SP2 CD

This section is only required if you want to install Internet Information Server (IIS) on the same system 
with SQL Server 2005. The IIS server is required for advanced SQL Server 2005 features such as Reporting 
and Analysis Services. For SQL installation requirements, see www.msdn2.microsoft.com/en-
us/library/ms143506.aspx.

Configuring Networking for SQL Server 2005 
This section provides information about configuring the network interface for connecting to the public 
network. 

 NOTE: The node requires a unique public IP address. The public IP address should be registered with DNS. 
If a DNS server is not available, then the IP address must be registered in the hosts file in the node.

For a single server running SQL Server 2005, it is recommended that at least two network interfaces are 
used, and that the interfaces be teamed to provide additional redundancy for the database server.

For a SQL Server 2005 cluster, each node must contain at least two network interfaces: one for the cluster 
interconnect (heartbeat), and one for client connections (public). It is recommended that a third 
interface be added, which allows network interface teaming to be employed on the public network. NIC 
Teaming is not supported on the heartbeat network.

Configuring NIC Teaming for Your Public Network Adapters

The network teaming drivers and utilities must be installed before completing these steps. These items 
can be installed from the Dell Database Resource CD.

 NOTE: TCP Offload Engine (TOE) functionality for TOE-capable NICs is not supported in this solution.

1 Identify the two network adapters that will be used for NIC teaming.

2 Connect an Ethernet cable from each selected network adapter to the public network switch.

3 If you have Broadcom NICs, go to step 4. If you have Intel NICs on node 1, configure NIC teaming 
by performing the following steps: 

a Right-click My Computer and select Manage.

b In the Computer Management window, click Device Manager.

c Expand Network adapters.

d Right-click the Intel NIC, which is identified for NIC teaming and click Properties.

e The Properties window appears.

f Click on the Teaming tab.

g Select Team with other Adapters and click New Team.
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h Specify a name (for example, Public) for the NIC team and click Next.

i In the Select the Adapters to include in this Team box, select the remaining network adapters 
you identified for NIC teaming and click Next.

j From the Select a team Mode list, select Adaptive Load Balancing and click Next. 

k Click Finish to complete the teaming.

l The Team: Properties window displays.

m Click OK.

n Click OK to close the Properties window.

4 If you have Broadcom NICs, configure NIC teaming by performing the following steps. 

a On the Windows desktop, click Start and select Program→Broadcom→Broadcom Advanced 
Control Suite 2. 

The Broadcom Advanced Control Suite 2 window appears.

b Click Tools and select Create a Team.

The Broadcom Teaming Wizard window appears.

c Click Next.

d In the Enter the name for the team field, specify a name (for example, Public) and click Next.

e In the Team type area, select Smart Load Balancing (TM) and Failover (SLB) and click Next.

f In the Available Adapters box, select the network adapters you identified for NIC teaming and 
add them to the Team Members box.

g Click Next.

h Select Do not Configure a Standby Member and click Next.

i When prompted to Configure LiveLink select No and click Next. 

j In the Creating/Modifying a VLAN window, select No and click Next.

k In the last window, select Preview changes in Broadcom Advanced Control Suite 2 and click 
Finish.

l In the Broadcom Advanced Control Suite 2 window, select Apply.

A message appears cautioning that the network connection will be temporarily interrupted.

m Click Yes to proceed.

n In the IP Address Setting Reminder window, click OK.

o In the Broadcom Advanced Control Suite 2 window, click OK.
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Configuring the IP Addresses for Your Public Network Adapters

Use the following procedure to configure the IP addresses for the public network adapters. 

The network adapter status displays in the system tray after you perform the procedures in this section. 

1 Update the adapter’s network interface name, if required. Otherwise, go to step 2.

a Click Start and navigate to Settings → Control Panel → Network Connections.

b In the Network Connections window, right-click the public network adapter you want to rename, 
and select Rename.

c Rename the public adapter name to Public and press <Enter>.

2 Configure the IP addresses by doing the following: 

a Navigate to Start → Settings → Control Panel → Network Connections and then right-click the 
public adapter that you configured in step 3 or step 4 of the "Configuring NIC Teaming for Your 
Public Network Adapters" on page 10 and select Properties. 

A Properties window displays.

b Double-click Internet Protocol (TCP/IP) in the list displayed under This connection uses the 
following items. 

c Click Use the following IP address. 

d Enter the following information and then click OK. 

• IP address 

• Subnet mask 

• Default gateway address 

• DNS server IP address 

e In the Public Properties window, select Show icon in notification area when connected.

f Click OK.

g Close the Network Connections window.

3 Add the public IP address and the host name to the following file:

%SystemRoot%\system32\drivers\etc\hosts.

 NOTE: Add the public IP address to the hosts file only if it is not registered with DNS. 

4 Ensure that the node can communicate with the public network.

5 Open a command prompt window. 

6 Verify that the network adapter responds to the following ping commands. 

a At the command prompt, type: 

ping <public_host_name>

where <public_host_name> is the host name 
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b At the command prompt, type: 

ping <network_gateway>

where <network_gateway> is the IP address of the network gateway. 

If the node’s network adapter does not respond to ping commands, check your network configuration 
and then repeat this step. 

Configuring the IP Addresses for Your Private Network Adapters

If you are installing a SQL Server 2005 cluster, each node will require a static IP address for the private 
(heartbeat) network. These addresses must be on the same subnet, which must be different than that 
used for the public network. For more information, refer to the Dell PowerEdge Cluster Information and 
Troubleshooting Guide on support.dell.com.

Use the following procedure to configure the IP addresses for the private network adapters. 

The network adapter status displays in the system tray after you perform the procedures in this section. 

1 Update the adapter’s network interface name, if required. Otherwise, go to step 2.

a Click Start and navigate to Settings → Control Panel → Network Connections.

b In the Network Connections window, right-click the public network adapter you want to rename, 
and select Rename.

c Rename the public adapter name to Private and press <Enter>.

2 Configure the IP addresses by doing the following: 

a Navigate to Start → Settings → Control Panel → Network Connections and then right-click the 
private adapter that you configured in step 3 or step 4 of the "Configuring NIC Teaming for Your 
Public Network Adapters" on page 10 and select Properties. 

A Properties window displays.

b Double-click Internet Protocol (TCP/IP) in the list displayed under This connection uses the 
following items. 

c Click Use the following IP address. 

d Enter the following information and then click OK. 

• IP address 

• Subnet mask 

• Default gateway address 

• DNS server IP address 

e In the Private Properties window, select Show icon in notification area when connected.

f Click OK.

g Close the Network Connections window.
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3 Add the public IP address and the host name file: 

%SystemRoot%\System32\drivers\etc\hosts

 NOTE: Add the private IP address to the hosts file only if it is not registered with DNS. 

4 Ensure that the node can communicate with the public network.

5 Open a command prompt window. 

6 Verify that the network adapter responds to the following ping commands. 

a At the command prompt, type: 

ping <public_host_name>

where <public_host_name> is the host name 

b At the command prompt, type: 

ping <network_gateway>

where <network_gateway> is the IP address of the network gateway. 

If the node’s network adapter does not respond to ping commands, check your network configuration and 
then repeat this step.

Configure Network Interface for Maximizing Data Throughput

1 Click Start, point to Settings, and then click Control Panel.

2 In the Control Panel, double-click Network Connections, and then double-click on the virtual adapter 
created in step 3 or step 4 of the "Configuring NIC Teaming for Your Public Network Adapters" on 
page 10. 

3 On the General tab, click Properties, select File and Printer Sharing Microsoft Networks, and then 
click Properties. 

4 Click Maximize data throughput for network applications option on the Server Optimization tab.

Configuring External Storage for SQL Server 2005

Hardware Overview for Standalone SAS

The Dell Solution for Microsoft SQL Server 2005 offers support for the Dell™ PowerVault™ MD3000 
SAS storage array and the Dell|EMC CX3-series Fibre Channel storage arrays. Either type of array can 
be configured in a direct-attached configuration with an SQL Server running on either a single server or 
a cluster. The Dell|EMC CX3-series arrays may also be configured in a Fibre Channel Storage Area 
Network (SAN).

Figure 1-1 and Table 1-1 illustrate the required server connections for a Direct-Attached SAS storage.
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Figure 1-1. Hardware Connections in a Dell Solution for SQL Server 2005

Table 1-1. Hardware Interconnections for a Direct-attached SAS Storage  

Component Connections 

Each PowerEdge Server One CAT5e/6 cable from the NIC to the public local area network 
(LAN).

If clustered, one CAT5e/6 cable from an additional NIC to the 
private (heartbeat) local area network (LAN).

If available, one CAT5e/6 cable from an additional NIC to the public 
local area network (LAN).

Each Storage Array One CAT5e/6 from each storage controller or storage processor for 
array management.

Redundant Connections (SAS or FC) between the storage array and 
the PowerEdge server(s).

See "Cabling the Storage Systems" on page 16 for more information.

Clients or Application Servers

PowerEdge Server(s)
for SQL Server 2005

Optional SAN Fabric

Dell PowerVault or
Dell EMC Storage Array
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Cabling the Storage Systems
This section provides information for connecting your cluster to a storage system.

Storage management can be either in-band through the SAS connection, or out-of-band using an 
Ethernet connection. For out-of-band storage management, cable the Ethernet ports on the storage array 
to the public network.

 NOTE: Dell recommends that you configure your Dell PowerVault MD3000 to use both in-band and out-of-band 
management paths. Establishing all management connections to a RAID enclosure provides additional paths in the 
case of a management connection failure.

Cabling the Standalone Server in Redundant Configuration With Dual SAS 5/E HBAs

Each server attaches to the storage system using one SAS 5/E HBA and two SAS cables. In this 
configuration, there are redundant storage paths from the server to the storage system. If a component 
fails in the storage path such as the port, the cable, or the storage controller, the multi-path software 
automatically reroutes the I/O requests to the alternate path so that the storage array continues to 
operate without interruption.

To cable the server:

1 Install a SAS cable from the server HBA 1 port 0 to the RAID controller module 0 port In 0. 

2 Install a SAS cable from the server HBA 2 port 0 to the RAID controller module 1 port In 0.

Figure 1-2. Redundant Configuration With Dual SAS 5/E HBA
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Cabling the Cluster in Redundant Configuration With Single SAS 5/E HBAs

Each cluster node attaches to the storage system using one SAS 5/E HBA and two SAS cables. In this 
configuration, there are redundant storage paths from the cluster node to the storage system. If a 
component fails in the storage path such as the port, the cable, or the storage controller, the multi-path 
software automatically reroutes the I/O requests to the alternate path so that the storage array continues 
to operate without interruption.

To cable the cluster:

1 Connect cluster node 1 to the storage system. 

a Install a SAS cable from the cluster node 1 HBA port 0 to the RAID controller module 0 port In 0. 

b Install a SAS cable from the cluster node 1 HBA port 1 to the RAID controller module 1 port In 0. 

2 Connect cluster node 2 to the storage system. 

a Install a SAS cable from the cluster node 2 HBA port 0 to the RAID controller module 0 port In 0. 

b Install a SAS cable from the cluster node 2 HBA port 1 to the RAID controller module 1 port In 0. 

 NOTE: If the HBA on the primary server fails, MSCS moves the cluster group to the other server and accesses the 
data through the other server.

Figure 1-3. Redundant Cluster Configuration With Single SAS 5/E HBA
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Cabling the Cluster in Redundant Configuration With Dual SAS 5/E HBAs

Each cluster node attaches to the storage system using two SAS 5/E HBAs and two SAS cables. In this 
configuration, there are redundant storage paths from the cluster node to the storage system. If a 
component fails in the storage path such as the HBA, the cable, or the storage controller, the multi-path 
software automatically reroutes the I/O requests to the alternate path so that the storage array continues 
to operate without interruption.

To cable the cluster:

1 Connect cluster node 1 to the storage system. 

a Install a SAS cable from the cluster node 1 HBA 1 port 0 to the RAID controller module 0 port 
In-0. 

b Install a SAS cable from the cluster node 1 HBA 2 port 0 to the RAID controller module 1 port 
In-0. 

2 Connect cluster node 2 to the storage system. 

a Install a SAS cable from the cluster node 2 HBA 1 port 0 to the RAID controller module 0 port 
In-1. 

b Install a SAS cable from the cluster node 2 HBA 2 port 0 to the RAID controller module 1 port 
In-1. 

Figure 1-4. Redundant Cluster Configuration With Dual HBAs
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Cabling the Dell|EMC Fibre Channel Storage Systems

This section provides information for connecting your standalone server and cluster server to a storage 
system in a direct-attached or in a SAN-attached configuration.

Cabling configuration in a Direct-Attached environment

A direct-attached configuration consists of redundant Fibre Channel host bus adapter (HBA) ports 
cabled directly to a Dell|EMC storage system. Direct-attached configurations are self-contained and do 
not share any physical resources with other server or storage systems.

Cabling a Stand-alone Server

A server attaches to the storage system using two fiber optic cables with duplex local connector (LC) 
multimode connectors that attach to the HBA ports in the server and the storage processor (SP) ports in 
the Dell|EMC storage system. These connectors consist of two individual fiber optic connectors with 
indexed tabs that must be aligned properly into the HBA ports and SP ports.

 NOTICE: Do not remove the connector covers until you are ready to insert the connectors into the HBA port, SP 
port, or tape library port. 

 NOTE: The connections listed in this section are representative of one proven method of ensuring redundancy in 
the connections between the server and the storage system. Other methods that achieve the same type of 
redundant connectivity may be acceptable.

To cable, do the following steps:

1 Install a cable from a server HBA port 0 to SP-A port FE 0. 

2 Install a cable from a server HBA port 1 to SP-B port FE 0. 

Figure 1-5 and Figure 1-6 illustrate methods of cabling a server direct-attached to a CX3-20 and CX3-40 
storage system, respectively.

 NOTE: The cables are connected to the storage processor ports in sequential order for illustrative purposes. 
While the available ports in your storage system may vary, HBA port 0 and HBA port 1 must be connected to SP-A 
and SP-B, respectively.
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Figure 1-5. Cabling the Server Direct-attached to a CX3-20 Storage System Using two Single Port FC HBAs.

Cabling the Cluster Servers

Each cluster node attaches to the storage system using two fiber optic cables with duplex local connector 
(LC) multimode connectors that attach to the HBA ports in the cluster nodes and the storage processor 
(SP) ports in the Dell|EMC storage system. These connectors consist of two individual fiber optic 
connectors with indexed tabs that must be aligned properly into the HBA ports and SP ports.

 NOTICE: Do not remove the connector covers until you are ready to insert the connectors into the HBA port, SP 
port, or tape library port. 

 NOTE: The connections listed in this section are representative of one proven method of ensuring redundancy in 
the connections between the cluster nodes and the storage system. Other methods that achieve the same type of 
redundant connectivity may be acceptable.

To cable the cluster:

1 Connect cluster node 1 to the storage system. 

a Install a cable from cluster node 1 HBA port 0 to SP-A port FE 0. 

b Install a cable from cluster node 1 HBA port 1 to SP-B port FE 0. 

2 Connect cluster node 2 to the storage system. 

a Install a cable from cluster node 2 HBA port 0 to SP-A port FE 1. 

b Install a cable from cluster node 2 HBA port 1 to SP-B port FE 1. 

Figure 1-5 and Figure 1-6 illustrate methods of cabling a two-node direct-attached cluster to a CX3-20 
and CX3-40 storage system, respectively.
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 NOTE: The cables are connected to the storage processor ports in sequential order for illustrative purposes. 
While the available ports in your storage system may vary, HBA port 0 and HBA port 1 must be connected to SP-A 
and SP-B, respectively.

Figure 1-6. Cabling the Cluster Nodes Direct-attached to a CX3-20 Storage System

Cabling Configurations in a SAN-Attached Environment

A SAN-attached cluster is a cluster configuration where all standalone servers or cluster nodes are 
attached to a single storage system or to multiple storage systems through a SAN using a redundant 
switch fabric.

SAN-attached cluster configurations provide more flexibility and more performance and are more 
expandable than direct-attached configurations. 

 NOTE: The connections listed in this section are representative of one proven method of ensuring redundancy in 
the connections between the cluster nodes and the storage system. Other methods that achieve the same type of 
redundant connectivity may be acceptable.

The Stand-alone servers and cluster nodes attach to the storage system using a redundant switch fabric 
and fiber optic cables with duplex LC multimode connectors. 
Deployment Guide 21



The switches, the HBA ports in the cluster nodes, and the SP ports in the storage system use duplex LC 
multimode connectors. The connectors consist of two individual fiber optic connectors with indexed 
tabs that must be inserted and aligned properly in the small form-factor pluggable (SFP) module 
connectors on the Fibre Channel switches and the connectors on the cluster nodes and storage systems.

Each HBA port is cabled to a port on a Fibre Channel switch. One to four cables connect from the 
outgoing ports on a switch to a storage processor on a Dell|EMC storage system.

Cabling a Stand-alone Server

1 Connect a standalone server to the SAN

a Connect a cable from HBA port 0 to Fibre Channel switch 0 (sw0). 

b Connect a cable from HBA port 1 to Fibre Channel switch 1 (sw1). 

2 Connect the storage system to the SAN. 

a Connect a cable from Fibre Channel switch 0 (sw0) to SP-A port FE 0. 

b Connect a cable from Fibre Channel switch 0 (sw0) to SP-B port FE 1. 

c Connect a cable from Fibre Channel switch 1 (sw1) to SP-A port FE 1. 

d Connect a cable from Fibre Channel switch 1 (sw1) to SP-B port FE 0. 

Figure 1-7. Cabling a Stand-alone Server to the Dell|EMC CX3-20 SPE
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Cabling the Cluster Servers

1 Connect cluster node 1 to the SAN. 

a Connect a cable from HBA port 0 to Fibre Channel switch 0 (sw0). 

b Connect a cable from HBA port 1 to Fibre Channel switch 1 (sw1). 

2 Repeat step 1 for each node. 

3 Connect the storage system to the SAN. 

a Connect a cable from Fibre Channel switch 0 (sw0) to SP-A port FE 0. 

b Connect a cable from Fibre Channel switch 0 (sw0) to SP-B port FE 1. 

c Connect a cable from Fibre Channel switch 1 (sw1) to SP-A port FE 1. 

d Connect a cable from Fibre Channel switch 1 (sw1) to SP-B port FE 0. 

Figure 1-8. Cabling a SAN-Attached Cluster to the CX3-20 SPE

Setting Up Your Storage Array

Once your nodes have access to the storage array, careful consideration is required to achieve the best 
performance. Several factors can affect performance; for example, workload, user connections, physical 
server configurations, and size of database. For more information, please visit dell.com/sql.

Below are some basic recommendations to deploy your system for testing purposes. Depending on your 
application requirements, these settings may not apply. Please consult with your Dell account 
representative for additional services.
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Table 1-2 and Table 1-3 show a simple layout for a two physical processor system.

 NOTE: For more Storage Best practices, please refer to the Reference Architecture document on dell.com/sql.

Storage must be configured with a minimum of three virtual disks created and assigned to the node.

Table 1-2. Storage LUN Layout

Storage Processor Virtual Disks

SPA TEMPDB, DATA2, QUORUM

SPB DATA1, LOGS

Table 1-3. Storage Layout Example

Disk Number 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14

Storage Layout Assignments

LUN1 — 

Quorum

LUN2 —

TEMPDB

1+1 
RAID 1/0

SPA

LUN3 — LOGS

2+2 RAID 1/0

SPB

LUN4 — DATA1

2+2 RAID 1/0

SPB

LUN5 — DATA2

2+2 RAID 1/0

SPB

HotSpare

Table 1-4. LUN/Virtual Disk Configuration and Sizes

LUN/Virtual Disk Minimum Size Number of 
Partitions 

 Used For 

Assign as many virtual disks to the database 
as the number of processors in the node. 

NOTE: For best performance it is recommended 
to assign as many virtual disks to the database as 
the number of processors in the node. For example, 
if the node has two processors, assign two virtual 
disks to the database. 

Database size / n 

For example, if there 
are two LUNs/virtual 
disks, each LUN/virtual 
disk will be the size of 
the database divided 
by two. 

1 Database

1 LUN/virtual disk Depending on required 
temp database size

1 Temp database

1 LUN/virtual disk 10% of database size 1 Log file

NOTE: This is required for clustering only.

1 LUN/virtual disk 1 GB 1 Quorum disk
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 NOTE: Applications utilizing SQL Server as a back end may have specific requirements dictated by the design 
characteristics of the application and are beyond the scope of this Deployment Guide. For application-specific 
guidelines and recommendations as they relate to physical and logical database layout, please contact your 
application provider.

Installing the Host-Based Software Needed for Storage

Follow the documentation accompanying the storage device to install the appropriate host-based storage 
software, drivers for storage controller, and multi-path driver software for your storage array. Please refer 
to the Solution Deliverables List (SDL) for the latest versions.

Preparing the Disks for Installing the SQL Server 2005 Database
1 Open a Windows command prompt. 

2 Type the following at the Windows command prompt: 

diskpart

3 Type the following at the DISKPART prompt: 

list disk

4 Type the following at the DISKPART prompt: 

select disk <n>

where <n> is the disk number corresponding to the virtual disks assigned to the host which needs 
to be partitioned. 

 NOTE: EMC recommends aligning the partition at 64. The EMC CX3 default stripe size is 64KB, and the Dell 
PowerVault default stripe size is 128KB.

5 Type the following at the DISKPART prompt: 

create partition primary align=128 

6 Repeat step 3 through step 5 for all other external disks identified in Table 1-4. 

7 Close the window for the command prompt. 

8 Use the following procedure to assign a drive letter to all external disks.

a Right-click My Computer and select Manage.

b In the Computer Management window expand Storage and click on Disk Management. 

c In the Disk Management window, right-click the partition area and select Change Drive Letter 
and Paths. 

d Click Add.

e Click Assign the following drive letter and select an appropriate drive letter from the drop-down 
menu.

f Click OK.
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9 Use the following procedure to format all external disks to NTFS.

a In the Disk Management window, right-click the partition area and choose Format. 

b Enter volume label (optional) in the Volume label field. 

c Choose NTFS in the File system pull down menu. 

d Choose 64K in the Allocation unit size pull-down menu.

e Click OK.

f Click OK when the format warning message displays. 

g Close the Computer Management window.

Verifying Hardware and Software Configurations
Before you begin database server setup, ensure that the hardware installation, network interfaces, and the 
node software are configured correctly.

Configuring MSCS Clustering for SQL Server 2005
When MSCS is installed properly, the service starts on each node and responds automatically in the 
event that one of the nodes fails or goes offline. To provide application failover for the cluster, the MSCS 
software must be installed on each cluster node.

Verifying Cluster Readiness

To ensure that your server and storage systems are ready for MSCS installation, ensure that these systems 
are functioning correctly and verify the following:

• All cluster servers are able to log on to the same domain.

• The shared disks are partitioned and formatted, and the same drive letters that reference logical drives 
on the shared storage system are used on each node.

• All IP addresses and network names for each cluster node are communicating with each other and the 
public network.

Configuring Microsoft Cluster Service (MSCS) With Windows Server 2003

The following procedure is performed on Node 1. 

 NOTE: It is recommended to shut down Node 2 prior to configuring the cluster. Shutting down Node 2 assures that 
the cluster disks are protected and assigned to the cluster correctly.

To create a new cluster on Node 1:

1 Click the Start button, select Programs→ Administrative Tools→ Cluster Administrator.

2 From the File menu select Open Connection. 
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3 In the Action box of Open Connection to Cluster window, select Create new cluster.

The New Server Cluster Wizard window appears.

4 Click Next to continue.

5 Follow the procedures in the wizard, and then click Finish.

6 Add the additional node(s) to the cluster.

a Turn on the remaining node(s).

b Click the Start button, select Programs→ Administrative Tools, and then double-click Cluster.

c Click Administrator.

d From the File menu, select Open Connection.

e In the Action box of the Open Connection to Cluster window, select Add nodes to cluster.

f In the Cluster or Server name box, type the name of the cluster or click Browse to select an 
available cluster from the list, and then click OK.

The Add Nodes Wizard window appears.

If the Add Nodes Wizard does not generate a cluster feasibility error, go to step g.

If the Add Nodes Wizard generates a cluster feasibility error, go to the next section, "Adding Cluster 
Nodes Using the Advanced Configuration Option."

g Click Next to continue.

h Follow the procedures in the wizard and click Finish.

Adding Cluster Nodes Using the Advanced Configuration Option

 NOTE: If you are adding additional nodes to the cluster using the Add Nodes wizard and the nodes are not 
configured with identical internal storage devices, the wizard may generate one or more errors while checking 
cluster feasibility in the Analyzing Configuration menu. If this situation occurs, select the Advanced Configuration 

option in the Add Nodes wizard to add the nodes to the cluster.

To add the nodes using the Advanced Configuration Option:

1 From the File menu in Cluster Administrator window, select Open Connection.

2 In the Action box of the Open Connection to Cluster window, select Add nodes to cluster and then 
click OK.

The Add Nodes Wizard window appears.

3 Click Next.

4 In the Select Computers menu, click Browse.

5 In the Enter the object names to select (examples), type the names of one to seven systems to add to 
the cluster, with each system name separated by a semicolon.

6 Click Check Names.
Deployment Guide 27



The Add Nodes Wizard verifies and underlines each valid system name.

7 Click OK.

8 In the Select Computers menu, click Add.

9 In the Advanced Configuration Options window, click Advanced (minimum) configuration, and 
click OK.

10 In the Add Nodes window, click Next.

 NOTE: In the Analyzing Configuration menu, Cluster Administrator analyzes the cluster 
configuration. If Cluster Administrator discovers a problem with the cluster configuration, a warning 
icon appears in the Checking Cluster Feasibility window. Click the plus ("+") sign to review any 
warnings, if needed.

11 Click Next to continue.

12 In the Password field of the Cluster Service Account menu, type the password for the account used to 
run the Cluster Service, and click Next.

13 The Proposed Cluster Configuration menu appears with a summary and the configuration settings for 
your cluster.

14 Click Next to continue.

The new systems (hosts) are added to the cluster. When completed, Tasks completed appears in the 
Adding Nodes to the Cluster menu.

 NOTE: This process may take several minutes to complete.

15 Click Next to continue.

16 In the Completing the Add Nodes Wizard window, click Finish.

Verifying MSCS Operation

After you install MSCS, verify that the service is operating properly. 

To verify that the MSCS service is operating properly:

1 Click the Start button and select Programs→ Administrative Tools, and then select Services.

2 In the Services window, verify the following:

In the Name column, Cluster Service appears.

In the Status column, Cluster Service is set to Started.

In the Startup Type column, Cluster Service is set to Automatic.

Creating a Cluster Resource Group for SQL Server 2005

When you create the cluster, MSCS will create a Cluster Group for management, and will create an 
additional group for each shared disk that is detected during cluster initialization. Because SQL Server 
uses multiple disks, it is recommended to modify the default configuration. 
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Follow these steps to create a resource group for SQL Server 2005 that contains all of the data, log, and 
tempdb disks that will be used by the clustered SQL Server instance:

1 Right-click one of the groups and rename to SQL Server.

2 Identify the disks that should be in the SQL Server Group from the other additional groups, and move 
each additional disk by clicking and dragging to the SQL Server Group.

The goal is to have all available SQL disks on one Resource Group.

Installing SQL Server 2005 Database

Pre-Install Preparation

 NOTE: Using multiple files is a best practice. The names provided below are just examples.

1 Create <n> folders on each of the external disks assigned to the database where <n> is equal to the 
number of cores in the processor. For example, if the processor is dual core, then create two folders on 
each of the external disks.

2 Name each of the folders that you created in step 10 using the following naming convention:

    MSS_DATA_<number>

where <number> is a number that increments for each folder. For example, MSS_DATA_1 and 
MSS_DATA_2 and so on.

The following is an example file system layout for the database for a node with two dual core 
processors:

E:\(MSS_DATA_1), (MSS_DATA_2)

F:\(MSS_DATA_3), (MSS_DATA_4)

3 Create two folders on the external disk assigned to the log. Name the folders as follows:

MSS_LOG1

TEMPDB_LOG1

4 Create a folder on the external disk assigned for the tempdb database and name it as follows:

TEMPDB_DATA_1

Configuring a Windows Account to Enable Instant File Initialization

To enable instant file initialization for data or tempdb files in SQL Server 2005, you must run the SQL 
Server 2005 service account under a Windows account and assign the Windows 
SE_MANAGE_VOLUME_NAME permission to that Windows account. 

1 Log into the SQL Server 2005 using an account that has administrative privileges. 

2 Click Start, point to Settings, and then click Control Panel. 
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3 In the Control Panel window, double-click Administrative Tools.

4 In the Administrative Tools window, double-click Local Security Settings. 

5 In Local Security Settings window, expand Security Settings, and then expand Local Policies.

6 Select the User Rights Assignment folder. 

The policies will be displayed in the details pane.

7 In the pane, double-click Perform Volume Maintenance Tasks.

8 On the Local Security Setting tab, click Add.

9 In the Select Users or Groups dialog box, add the Windows account that will be used to run the SQL 
Server process (sqlservr.exe). 

 NOTE: By default, SQL Server 2005 runs under the Local System account. 

10 Click OK. 

11 Click OK to close the Perform Volume Maintenance Tasks window.

12 Reboot the node.

Installing the SQL Server 2005 Database Software

This section provides information about installing the SQL Server 2005 software. The following topics 
are covered: 

• Installing SQL Server 2005 Database 

• Installing Service Pack 2 for SQL Server 2005 

 NOTE: For local installations, you must run setup as an administrator. If you install from a network share,
you must use a domain account that has read and execute permissions on the network share.

1 Insert the SQL Server 2005 install media into your CD or DVD drive. The install program should 
launch automatically. If it does not launch, then do the following to launch the install: 

a Click Start and select Run.

b In the Run window, type the following and click OK.

%DVD Drive%\splash.hta 

c If installing from a network share, navigate to the network folder and launch splash.hta by 
clicking on it. 

2 Select Server components, Tools, Books Online, Samples. 

3 On the End User License Agreement page, read the license agreement, and then select the check box 
to accept the licensing terms and conditions. Click Next to continue. 

4 The Installing Prerequisites page displays the components required for SQL Server 2005. To install 
these components, click Install. 

5 Click Next after the components are installed. 

6 On the Welcome to the Microsoft SQL Server Installation Wizard page, click Next.
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7 On the System Configuration Check page, the system is scanned for conditions that may block setup. 
Make sure all the requirements are met successfully. To proceed with setup after the scan completes, 
click Next. 

8 On the Registration Information page, enter information in the Name and Company text boxes, 
enter your 25-character product key and click Next.

9 On the Components to Install page, select the components for your installation. The following 
selections provide the minimum installation of SQL Server 2005 on a single node. Other selections 
may be optionally installed once the minimum requirement is complete.

– SQL Server Database Services 

– In case of cluster, select Create a SQL Server failover cluster.

 NOTE: For more information about Reporting Services, Analysis Services, Notification Services and Integrations 
Services, refer to the SQL Server 2005 Books Online or to www.microsoft.com/sql.

Click Next when you have completed your selections. 

10 On the Instance Name page, select an instance for your installation.

– If this is a new installation select Default instance.

– If a default or named instance is already installed, click Named Instance and then type a unique 
instance name in the space provided.

 NOTE: Always use Named Instance for cluster installations.

– Click Next.

If this is a non-cluster configuration go to step 16.

11 On cluster configuration type a Virtual server name on the Virtual Server Name page, Click NEXT.

12 On the Virtual Server Configuration page, specify Public network and an available IP address, Click 
Add to add the public IP address, then click Next.

13 Select the SQL Server resource group that was previously created in the "Creating a Cluster Resource 
Group for SQL Server 2005" on page 28.

Enter the Data Files location. This location determines where the master database files will be 
installed. A location on a shared disk that is part of the SQL Server Cluster Resource Group should be 
selected to ensure that the database can failover between nodes.

 NOTE: Unavailable cluster groups will show any group that already has a SQL Server instance. Only one instance 
can be installed per Cluster Group.

14 In the Cluster Node Configuration page, verify that the failover node appears under Selected Nodes. 
Click Next.

15 On the Remote Account Information page, type in the password of the domain account that has 
permission rights to run the SQL instance on all cluster nodes.
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16 On the Service Account page, select Use the built-in System account.

To use a domain user account, select Use a domain user account and enter the username, password 
and domain name.

 NOTE: The domain name cannot be a fully qualified Domain Name System (DNS) name. For example, if your DNS 
name is domain-name.com, use domain-name in the Domain field. SQL Server 2005 does not accept domain-

name.com in the Domain field.

To specify an individual account for each service, select Customize for each service account. Select 
a service name from the drop-down box, and then provide login credentials for the service. 

17 Click Next.

18 On the Domain Groups for Clustered Services page, enter the DomainName\GroupName that you 
have set up in domain under the SQL Server box. 

a Enter the DomainName\GroupName that you have set up in domain under the SQL Server Agent 
box 

b Enter the DomainName\GroupName that you have set up in domain under the Full-Text Search 
box. 

c Click Next.

19 On the Authentication Mode page, choose the authentication mode to use for your SQL Server 2005 
installation and click Next. 

 NOTE: Enter and confirm the password for the system administrator (sa) login account when you choose Mixed 

Mode Authentication. Do not set a blank password for the sa login account. 

20 On the Collation Settings page, click Next.

www.msdn2.microsoft.com/en-us/library/ms144260.aspx.

21 If you selected Reporting Services as a feature to install, the Report Server Installation Options page 
is displayed. Do one of the following:

– Select the radio button to configure the report server with default values. 

– For a custom configuration, choose the Install but do not configure the server installation option. 

22 Click Next.

23 On the Error and Usage Report Settings page, click Next.

24 On the Ready to Install page, review the summary of features and components for your SQL Server 
2005 installation and click Install. 

25 If prompted, insert SQL Server 2005 CD 2. 

26 Click OK.

27 On the Setup progress page, click Next.

28 On the Completing the Microsoft SQL Server Installation Wizard page, click Finish.
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29 If you are instructed to restart the computer, do so now. Be sure to read the message from the Setup 
program when you complete the installation. 

 NOTE: Failure to restart the computer may cause failures when you run the Setup program in the future.

Installing Service Pack 2 for the SQL Server 2005 Database 

1 Close all applications before proceeding. 

2 Right-click My Computer and select Manage. 

3 Expand Services and Applications. 

4 Select Services. 

5 In the Services window, stop all SQL Server services:

a Right-click the services that begin with SQL Server and that have a status of Started

b Select Stop.

 NOTE: If you are installing SQL SP2 on a cluster setup, stop the Cluster Service.

6 Insert the SQL Server 2005 SP2 CD into the CD drive.

7 Double-click the SQL Server 2005 SP2 executable to start the install.

8 In the Welcome page, click Next.

9 In the End User License Agreement page, read the license agreement; select the check box to accept 
the License Terms agreement and click Next. 

10 In the Feature Selection page, accept the defaults and click Next.

11 In the Authentication page, select the authentication mode you selected for SQL Server 2005 during 
the installation and click Next.

 NOTE: If you select the SQL Server Authentication mode, enter the sa password you entered in step 19 of 
"Installing the SQL Server 2005 Database Software" on page 30. In case of cluster, enter the domain user 
credentials on the Remote User Account page.

The Remote User Account page will appear if it is a cluster configuration. Type the user information that 
has been configured to run the cluster service.

12 Accept the defaults in the Error and Usage Reporting Settings window and click Next.

13 The Running Processes page lists the processes that are locking files required for the SP2 update.

 NOTE: If any files are listed here, then a Reboot is required after installing SP2.

14 In the Ready to Install page, click Install.

15 If a Computer Reboot Required message displays, click OK in the message box.

16 In the Installation Process page, click Next.

17 In the Installation Complete page, click Next.

 NOTE: In cluster configurations, SQL SP2 needs to be installed on each node.
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18 In the Additional Information window, click Finish.

19 Reboot the computer.

Additional Information
For SQL Server 2005 database best practices, please refer to the Reference Architecture White paper on 
dell.com/sql.
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